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Example Programs

Understanding the One of the best ways to learn how to use the OP-panel is to load the example
Example Programs programs which are on the supplied diskette, and run the program for your PLC. The
example program provides ladder logic which demonstrates controlling
pushbuttons, LEDs, lamps, and force operations. Use an understanding of this
example program to help develop programs for your own applications.
Follow the instructions in this chapter for installing and running the example
programs.
Software
Requirements

The example programs require that you have two software packages loaded on your
personal computer:
S DirectSOFT programming software, and
S OP-WINEDIT (OptiMate Editor) configuration software.
If you do not have these software packages, obtain and install them on your personal
computer using the instructions in their user manuals.
Once you have both programs installed on your personal computer you are ready to
use the following step-by-step instructions for installing and using the example
programs.
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9 Steps to Using the Example Programs
Step 1: Power
Supply Connections

An external power supply should be used to power the Optimation unit. The power
supply must supply a voltage of 8 to 30 VDC. Connect the power supply using the
supplied terminal block connector. The connector is keyed to prevent reversing the
polarity. Pin 1 is the positive connection (8 to 30VDC), while pin 2 is the common
(0VDC) or ground connection.
Use 18–24 AWG conductor wire and connect the
power supply to the supplied connector block as
follows: Connect the positive (+8 to 30 VDC) lead to
terminal 1, and connect the common ground (0V)
lead to terminal 2.
Receptacle

Terminal 2
1

Terminal 1

2

Ground
+24VDC

Plug the terminal block connector
into Power receptacle located on
the back side of the panel.

Step 1A:
Multi-Panel Power
Supply
Connections
(Optional)

In multi-panel applications, if using separate power supplies, make sure the
electrical ground commons do not have a great potential difference. When using a
single power supply in a multi-panel application, the power supply must maintain the
specified voltage and current consumption for each of the individual units under all
conditions (including power-up). See individual panel power requirements.

(Communications to PLC)

+

OP-9001

Power
Supply
J1

   

J2

(RS-422)

 

Panel 1

 
 

Power
Supply
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Step 2: Setting the
OP-Panel
PGM/RUN DIP
Switch to PGM

You may generate your OP-panel configuration off-line. To download your
configuration, the PGM/RUN DIP switch located on the back of the OP-panel must
be set to PGM (ON). The TERM switch should remain off.
NOTE: You must cycle power to the panel (turn power off, set DIP switch, and turn power
back on) to activate the new switch settings.

RUN

Step 3: Selecting
Cables

1
2

ON

PGM
TERM

Set to PGM

For multi-panel configurations, see the section titled OP-9001 Multi-Panel
Configurations towards the end of this chapter.
Depending on which PLC you are using, you may require as many as three cables to
use the example programs:
S

S

S

An OP–ACBL–1 configuration cable to connect your personal computer
to the OP-panel to load the configuration program into the panel. All
panels use the OP–ACBL–1 for the configuration cable. This cable is
also used to connect an OP-panel to an Allen-Bradley SLC 500 CPU.
A cable to connect your personal computer to the PLC to load the
DirectSOFT example ladder programs into your PLC. See the
DirectSOFT user manual for help in selecting the proper cable to use
with your PLC.
A cable to connect the OP-panel to the PLC. Use the information on the
next two pages to select the proper cable to use with your PLC.
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Choosing Your
Connecting Cables
Depending on which PLC you are
using, you may require as many as
two cables. Here are the
requirements:
D
OP-ACBL-1: all units require
this cable for configuration. This
is a 9-pin female to 15-pin male
cable that connects your
personal computer to the
OP-panel. This cable is also
used to connect an OP-panel to
the Allen-Bradley SLC 500
CPUs listed.
D CPU Cables: You will also need
the appropriate cable to connect
your CPU to the OP-panel. Use
the chart shown to the right to
choose
the
correct
communications cable.

OP-9001 Cable Connectors

OptiMate Cables
Family

D
D

D

OP-CMCON–1 — pack of 4
ribbon cable connectors.
OP-CMCON–2 — pack of 4
solder-type connectors.
OP-CMCON–3 — pack of 2
D–shell connectors with screw
terminals for use with OPĆ9001
& multiple OP-panels.
OP-PSCON — pack of 4 power
supply block connectors.

For electrically noisy environments,
we recommend an individually paired
and shielded cable, such as Belden
9729 or equivalent. This type of
cable requires the solder-type or
D-shell
with
screw
terminal
connectors. For distance of 30 feet or
less, you can use ribbon cable. For
ribbon cable, we recommend
Belden 9L28015 or 3M 3365/15.

* — requires RS232 Data Communications Unit (D3–232–DCU)
**– also DC versions

Port

Cable

DirectLOGICt
DL105

DL130

Only port

OP–2CBL

DirectLOGICt
DL205

DL230

Only port

OP–2CBL

DL240

Top port

OP–2CBL

Bottom port

OP–2CBL

Top port

OP–2CBL

Bottom port

OP–2CBL–1

D2–DCM (module)

Only port

OP-4CBL–2

DL330

Requires DCU*

OP–4CBL–2

DL330P

Requires DCU*

OP-4CBL–2

DL340

Top port

OP-3CBL

Bottom port

OP-3CBL

Top port

OP-2CBL

Bottom port

OP-4CBL-2

Top port (15-pin)

OP-4CBL–1

Bottom port (25-pin)

OP-4CBL–2

Top port

OP-4CBL–1

Bottom port

OP-4CBL–2

Phone Jack

OP-2CBL

Top port (15-pin)

OP-4CBL–1

DL250

DirectLOGICt
DL305

DL350

DirectLOGICt
DL405

If you’re planning to use multiple
panels and an OP-9001, then you
will need to build your own custom
cables. Since the proper cable
choice really depends on your
application, we offer the following
connectors.
D

CPU
(or other device)

DL430

DL440**

DL450

GE

Series 1

Bottom port (25-pin)

OP-4CBL–2

D4–DCM (module)

Only port

OP-4CBL–2

Slice I/O panels

Only port

OP-4CBL–1

IC610CPU105/106

Requires DCU*

OP-4CBL–2

GE Seriest 90/30

All Models (311–351)

RS232, RS422
Serial Port

OP-GCBL–1

GE Fanuct
Series 90 Micro

All Models

RS232, RS422
Serial Port

OP-GCBL–1

MODICON

ModBus

RJ45 port

OP-MCBL–1

TI305t /
SIMATIC TI305t

325–07, PPX:325–07

Requires DCU*

OP-4CBL–2

330–37, PPX:330–37

Requires DCU*

OP-4CBL–2

325S–07 (or 325 w/ Stage Kt)

Requires DCU*

OP-4CBL–2

330S–37, PPX:330S–37

Requires DCU*

OP-4CBL–2

335–37, PPX:335–37

Phone Jacks

OP-3CBL

TI405t /
SIMATIC TI405t

If DCU is used*

OP-4CBL–2

425–CPU, PPX:425–CPU **

Only port

OP-4CBL–1

PPX:430–CPU

Top port (15-pin)

OP-4CBL–1

Bottom port (25-pin)

OP-4CBL–2

Top port (15-pin)

OP-4CBL–1

435–CPU, PPX:435–CPU **

Bottom port (25-pin)

OP-4CBL–2

Smart Slicet I/O panels

Only port

OP-4CBL–1

A–B SLC 500

5/03, 5/04

Bottom port

OP-ACBL–1

A-B

MicroLogix

Only port

OP-ACBL–2
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Connecting Cable Details
Connecting Cable

RJ12 (PLC)
4
3
1

DB15
3
2
5

RJ11 (PLC)
2
1
4

DB15
3
2
5

DB15 (PLC)
2
3
4
13
14
15
1
7
8

DB15
3
2
5

DB25 (PLC)
2
3
7
4
5

DB15
3
2
5

8 Pin Mini DIN DB15
7
3
4
2
2
5

The OP–613 connecting cable may vary depending on which CPU you use. Refer to
the previous page to select the proper cable for connecting to your PLC.

1= 0V
2= not used
3= Din
4= Dout
5= not used
6= not used

RJ12
(6P6C)

RJ12

12 3 456

8= YOM
7= CTS
6= not used
5= not used
4= On-line
3= Din
2= Dout
1= YOP



13= not used
12= not used
11= not used
10= not used
9= not used
8= not used
7= 0V
6= not used
5= CTS
4= RTS
3= Din
2= Dout

1= not used

15= tied (0V)
14= tied (0V)
13= tied (0V)
12= not used
11= not used
10= not used
9= not used


4

DB15

12

DB15

 
DB25

Mini–DIN
5

DB15

 

DB15

3= Din
2= Dout
5 =0V

 

RS-422 Pinout
PLC
Din +
Din –
Dout +
Dout –
0V

DB15

 

25= not used
24= not used
23= not used
22= not used
21= not used
20= not used
19= not used
18= not used
17= not used
16= not used
15= not used
14= not used

6 7 8

DB15



RJ11
(4P4C)

1= Din
RJ11
2= Dout
3= not used
4= 0V
1 234

3



Panel
11 = Dout+
12 = Dout –
9 = Din +
10 = Din–
5 =0V

9= not used
10= not used
11= not used
12= not used
13= not used
14= not used
15= not used

RTS+
CTS+
RTS–
CTS–
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1= not used
2= Dout
3= Din
4= not used
5= 0V
6= not used
7= not used
8= not used
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(    
     

 




1
Female
DB9
3
2
5
7
8

9

5= 0V
4= not used
3= Dout
2= Din
1= not used

9=not used
8= CTS
7= RTS
6=not used

1



 

Male
DB15
3
2
5



9= not used
10= not used
11= not used
12= not used
13= not used
14= not used
15= not used

 

1= not used
2= Dout
3= Din
4= not used
5= 0V
6= not used
7= not used
8= not used

Step 5: Installing
It is possible to load the examples from the diskette; however, we recommend
copying them to the hard drive in your computer and keeping the original diskette in a
the Example
Programs on Your safe place.
Personal Computer
Hard Drive
a:\filename.prj

To install the example programs if using Windows 3.1, follow these steps:
1. Call up the DOS Prompt. Make a new directory on the hard drive in your
computer. For example,
if the hard drive is drive C and you are using an OP-613 panel, type:
MD C:\OP–613
2. Copy all the files from the example program disk to the new directory. For
example, if the diskette is in drive A: and the hard drive is drive C:, type:
COPY A:\*.* C:\OP–613\*.*
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Step 4: Connecting Once the example programs are loaded in your personal computer, the first step will
be to load the configuration program from the computer into the OP-panel, so make
Configuration
Cable OP–ACBL–1 this cable connection first. Connect the configuration cable between the serial port of
the OP-panel and the serial port of the personal computer when configuring panels
using the OP-WINEDIT software. The OP-WINEDIT software requires you to select
the serial port number (com1, com2) being used for configuration. The figure below
shows programming cable connectors and wiring specifications. Wiring diagrams
refer to the cable connectors, not the communication ports.

Installing and Using the Example Programs

To install the example programs if using WIN 95, follow these steps:
1. Select the Explorer icon and open. If the hard drive is drive C, select the
(C:) icon.
2. Make a new directory in the hard drive of your computer. For example, if
you are using an OP-613 panel, Select the File menu, then select New and
then Folder. Notice the New Folder icon that appears. Select the folder
and name it “OP-613” by selecting the File menu and selecting Rename.
Type in the new name.
3. Copy all the contents of the example program disk. Insert the diskette in
drive A, and select and open the 3 1/2 Floppy (A) icon. Notice the disk has
numerous files of example programs. Select all the programs by opening
the Edit menu and selecting Select All. Open the Edit menu again and
select Copy.
4. Paste the program disk contents into the new C drive “OP–613” directory.
Open the “OP–613” directory, open the Edit menu and select Paste.
The example programs are now loaded onto the hard drive of your computer.
Remove the diskette from drive A.

Step 6: Loading the The next step is to load the configuration program into the OP-panel as follows:
OP–WINEDIT
Example Program
1. Open the OP-WINEDIT (also called OPEditor) software.
into the OP–Panel
2. When the initial screen appears, select Existing System.
3. A File Open window appears. Open the example program file that you just
loaded on your hard drive (“OP-613”). A list of files appears, all having “.ocf”
after the file name. These are all configuration programs.
4. Select the configuration program for the OP-panel and PLC you are using.
For example, if you are using an OP-613 panel with a DL205 PLC, select
and open the file titled “613_205.ocf”.
5. A screen appears having all the configuration parameters for running the
example program using an OP-613 with a DL205 PLC. Make sure your
OP–ACBL–1 cable is connected between your personal computer and the
OP-panel, that the DIP switch slides are set to ON, and that the OP-panel
power supply is on. Select Configure Panel.
6. When the next window appears, select Write to Panel. This loads the
program into the OP-panel.
7. After the program is loaded, close the open windows and select Exit
Software. This closes out the OP-WINEDIT software.
The OP-panel is now configured, and the OP-ACBL-1 cable can be disconnected.
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Step 7: Setting the To run the example programs, set the RUN/PRG DIP switch to RUN.
OP-Panel PRG/RUN
DIP Switch to RUN
NOTE: You must cycle power to the panel (turn power off, set DIP switch, and turn
power back on) to activate new switch settings.
Set to RUN

RUN

1
2

ON

PGM
TERM

Step 8: Loading the The next step is to load the DirectSOFT example program into the PLC as follows:
DirectSOFT
Example Program
1. Connect the communications cable from your personal computer
into the PLC
communications port to your PLC’s programming port on the CPU.
2. Start DirectSOFT on your personal computer.
3. Select Open Document.
4. A dialog box appears. Open the example program file that you just loaded
on your hard drive (”OP-613”). A list of files appears, all having “.prj” after
the file name. These are the example program files. Notice that the
program files are named for the OP-panel and PLC being used and end
with “.prj”.
5. Select the example program for the OP-panel and PLC you are using. For
example, if you are using an OP-613 panel with a DL205 PLC, select and
open the file titled “613_205.prj”. When the program opens, its ladder rungs
will appear on the monitor screen.
6. Select the PLC menu, then Connect, then select the link to use. All the
program examples are saved without PLC link information, so you have to
re-connect to your particular CPU. If a message appears which asks you to
select the source of program to view, select Disk.
7. Make sure the CPU is in Program mode. Then download the program to the
CPU. One method is to select the File menu, Write Program..., then select
To PLC.
8. When the program download is complete, put the CPU in Run Mode. Select
the PLC menu, PLC Modes..., then select Run. The program is now
running.
Step 9: Connecting The next step is to connect the OP-panel to the PLC using the cable you selected
the OP-Panel to the earlier. Once the OP-panel is connected to the PLC you can run the example
PLC and Running program. Read through the following section, Running The OP-613 Example
Program, while at the same time actually running the program on your OP-panel. It
the Program
would be helpful to print a hardcopy of the example program and study the ladder
logic to see how the program operates.
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Running the
OP-613 Example
Program

The example program demonstrates the main features of the OP-613 panel:
S Custom pushbutton configuration
S Custom pushbutton LED configuration
S Custom lamp configuration
S The four field points and the four-digit numeric LED display
S Force operations.
 



 

55

  

  
If you look at the pre-configured OP-WINEDIT program you loaded into the
OP-panel earlier, notice that the four pushbuttons are set for momentary operation
and that the Force Option and LED Separation features are both activated (see
Configuration section for configuration details).
The example program operates as follows:
Notice that the pushbutton PB#1 LED is flashing. This LED is programmed to do this
at CPU powerup.
Next, press pushbutton PB#1. Pushbutton PB#1 LED and Lamp#1 both start
flashing for a short period of time, then Lamp#1 and pushbutton PB#3 LED both go
on steady while PB#1 LED goes off.
Press pushbutton PB#1 again. Pushbutton PB#1 LED and Lamp#1 both start
flashing for a short period of time, then Lamp#1 and pushbutton PB#3 LED both go
on steady while PB#1 LED goes off.
Next, press pushbutton PB#3 and notice that Lamp#1 flashes for a very short period
of time and then stays on steady. Pushbutton PB#3 LED stays on.
Press the Select pushbutton repeatedly to scroll through the four field point
locations and view their contents on the four-digit numeric display. Select the top
field point location and notice that the number “55” is entered. Use the up/down
(YB) arrow keys to change the numeric value in this location, then press PB#2 and
notice that “55” is forced into this location.
Print a hardcopy of the example program and study the ladder logic to see how the
program operates. Hopefully this example will help you utilize the OP-panel for your
own applications.
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OP-9001 Multi-Panel Configurations
If you are connecting more than one OptiMate panel to a single CPU this is referred
to as multi-panel configuration. MultiĆpanel configurations require the OP-9001
Communications Master, which the CPU communicates to for obtaining data from
the connected OP-panels. The OP-9001 Communications Master looks for an
address within the range of 0 to 30 for each panel connected. Each panel connected
in a RS-422 link must have a unique address. A more detailed description of multiple
panel configuration and installation is given in the OP–9001-M User Manual.
The Termination
Resistor

The last panel must be terminated when using a RS-422 communications link by
setting DIP switch 2 to the TERM (ON) position. Operator panels communicatiing
more than 50 feet distance must use RS-422 and also be properly terminated.
NOTE: Only the last panel of each RS-422 link should have the termination DIP
switch 2 set to the TERM position. All other panels should have the DIP switch set to
the off (left) position. After changing the DIP switch settings, remember to cycle
power on panel to activate the new switch settings.
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